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1 Introduction

o  About XRumer
o  How to start... 
o  Interface
o  Files structure
o  Advanced options
o  Tools
o Traffic saving algorithm 

1.1 About XRumer

  
XRumer is software which automatically posts messages and links to:

· Forums using phpBB and any of its modifications, Invision, Power Board (IPB), VBulletin, YaBB,
Icon Board and other engines: 
· Guestbooks;  
· Blogs;
· Live journals;  
· WiKi;  
· Bulletin boards;  
· Catalogs of links.  

While running, the software automatically finds and fills all fields with information, so is no need
to launch your  browser.  If  the  forum (blog,  guestbook)  requires  registration  to  post  messages –
the program will register, will log in and will post your message. 
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Exclusive feature:  software pass almost  all  forms of  protection  against  automatic  registration,
such as:  
· Pictocode (ticket) protection (i.e. Enter the number you see in the box:)  
· Protection that uses e-mail activation;  
· Java-script protection.  

You can see other capabilities of the software in the Description of work chapter.  

Software  updates  and  technical  support  can  always  be  found  on  the  developer's  official  site  -
http://www.botmasternet.com  

Demo-version limitations:  
1. You cannot change the text of the message.  
2. You cannot use multi-threading.  

1.2 How to start

   For demo version:
1. Start xpymep.exe program
2. Carefully read instructions in the window and click OK
3. Proceed according to instructions

   For full version:
1. Start xpymep.exe program.
2. Click on the menu Project → New, fill in the required fields.
3. Save the project.
4. Select the required database in the Links database tab; make sure the LinksList is selected.
5. Click Start from beginning button or Resume from the last position.

ATTENTION !!! 

If  you  are  planning  to  use  proxy,  do  not  forget  to  update  the  proxies  list  in  the  Anonymity  tab.
Besides that, to make the process more secure and stable, it is recommended to place the script on
any of your sites and set up the program :

-  Upload  proxyc  folder  to  any  of  your  sites  -  this  is  the  script  that  checks  if  proxy  is  really
anonymous.

- Open the menu Settings → Proxy-checking settings
-  In  field  Checker  script  address  choose  Use  own  address  and  enter  the  full  address  to  the

script. Use the browser to make sure you typed the address correctly and the script is placed properly
on the site.

1.3 Interface

1. Main window

http://www.botmaster.net
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1. Main menu:

Project – project editing menu (messages text, links, titles, nicknames and other information
is stored in this folder);  project  files have .xpy extensions and are stored in  the Projects  folder.
This is not accessible in the demo version.

 Tools  –  different  tools  for  working  with  the  links  database:  counting  totals,  removal  of
duplicates, sorting by topic number, black-list filtering etc.

 Options  -  editing  your  account  on  http://www.botmasternet.com  (login  and  password),
Proxy-connection setup, choice of links uploading mode of activation from a mail box (automatic
background / manual / switched - off), other options.

 Events log - the list of the processes and times that XRumer has performed. 
 Scheduler - management of scheduled tasks for future projects.   
 Self-learning - self-learning system to unknown fields of forms (textarea, input, select, etc.).

For experienced users only!   
 Plugins  - the list of downloaded plugins, start/stop plugins download.  
 Help – opens the help file.

2. Information : name of software, used version, contacts. 

3. Graphic logo. It can be hide in Option> Advanced option. 

4. In the right is shown available updates.  

5. TO CHECK THE DEMO VERSION: send a message to a single forum/guestbook/blog etc.
In  the  text  box  you  can  specify  URL  (link)  and  send  default  message  by  clicking  Test.  If  the
monitoring option has been set (see Advanced options) then you will be able to see the process
of posting in detail at the top of the window. The results are located in the Reports tab. Also in this
mode, a detailed report is stored in Debug folder. 

http://www.botmasternet.com
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6. Status bar. Here you see what the program is currently doing.
S - posting
M - downloading activation links from email box
P - updating proxies

7. The list of current threads. Here you can see the links that the program is currently using.

8. Chose of posting mode:  Posting or Mass-PM 

9. Posting management:
   Start  –  start  posting  from  the  beginning  of  selected  database.  Position  number  is  reset.

Also, old reports are deleted (if it's enabled appropriate option in Advanced option). 
   Resume  from  the  last  position  –  continues  the  process  from  last  position  where  was

stopped.   
   Stop  –  Stops  launching  of  new  threads.  Already  started  threads  will  continue  until  they

finish.

10. Program settings tabs:
  

Links database – in this tab are selected the database to forums/guestbooks/blogs etc. and
posting  mode.   Links  databases  is  a  text  file,  located  in  Links  folder  and  have  the  following
format: LinksList id*.txt, where * is its ID (database's number). 

ATTENTION!!! 
Before  starting  a  new  project,  make  sure  that  database  is  set  to  LinksList,  and  NOT  to

MLinksList or ZLinksList, etc.

   Reports – detailed reports on current processes.   
   Mail  –  Used to download the activation links from the e-mail  inbox.  It  is  recommended to

create  the  address  solely  for  posting purpose.  Login  and  password  to  this  e-mail  are  set  in  the
project file.   

   Anonymity – proxy-server usage settings.   
   Multi-threading settings – here you can select number of threads to run. As higher will be

the maximum number of concurrent threads – the faster will be the speed (the amount of threads
should correspond to bandwidth of your Internet – connection). At connection of 1Mb/sec (without
proxy)  it  is  recommended  to  use  15  treads  and  at  4  Mb/sec  use  60-70  treads.  Periodicity  –
10...1000 (it is recommended to not change). It makes sense to change this parameter only if you
want to reduce posting speed.  

IMPORTANT!!! 

If  in email  box will  be more than 500 letters waiting for  activation,  XRumer  automatically  will
TEMPORARILY reduce the number of treads to 5. This number of treads will be maintained until
all  letters  waiting  for  activation  will  be  downloaded.  Number  of  treads  will  be  restored,  after  all
letters will be downloaded.  (see background activation option) 

11. Same commands as in the Project menu.

2.  The project creation and editing window
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Project name - indicate the name of your project (it  is identical to file name created in Projects
folder).  

1. Personal information of user:
Nickname – nick (login). It is recommended to use only Latin letters exclusively 
Password - user password sign at registration into forums, blogs
Real name - on some sites at registration besides a nickname it is necessary to specify real
name of the user. It may be the same as nickname.
Homepage – the URL of promoted site. Which should begin with http: //
ICQ - number of ICQ (it must be not identical to yours)  
City  -  user’s  city.  Any  links  in  this  and  the  next  fields  are  forbidden  to  the  personal
information. 
Country – the country of residence of the user.
Area  of  work  -  a  trade/specialization/job  of  the  user.  It  is  possible  to  specify  several
profession, through a comma
Hobbies – user’s hobbies.
Signature – the signature in your profile (it can contain BB-code) 

IMPORTANT!!! 
To fill Signature field ONLY if it is necessary, because it may reduce success rate. Same as for
Text for unknown fields (in bottom of window)       

2.  Email  (contact  e-mail,  specified  at  registration  on  forum,  It  is  recommended  to  create  email
address solely for posting purpose for each new project):

Full address – full email address: login@site.com
Password – the password to this email 
Login – the login name 
POP-server address - for uploading letters under the POP-report, it is necessary to find out
the address on mail server. For example: on mail.ru the mail server address - pop.mail.ru
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Note: if you'll use a nonstandard POP mail service then you should enter POP address in xpop.txt
file, in field [PORT].

Below  these  fields  are  button  for  automatic  email  registration  on  mail.ru,  cashette.com,
gawab.com, web.de, gmail.com.

IMPORTANT!!! 
Before starting a new posting; check through a browser (Internet Explorer or other), that: 
1. email address specified in the project, is available on the specified data 
2. there is an opportunity of downloading letters under the POP3-report
3. this email is not used before in previous project 

3. Contents of posting messages:
Topic – the message subject. It is recommended to enter in this field 3-4 words at least
Explanation  – this field contains explanatory information to message subject. This field is

required on some forums (IPB, etc.)
Message  text  –  the  text  of  posting  messages  can  contain  links,  macros  and  the  other

information

4. To create polling (Poll) - an option for creation of polls with variants of answers at forums. It is
forbidden to use links in these fields. Do not confuse with Question – answer system.

5. Thematically targeting:  
Priority  categories   -  the list  of  priority  categories  which  contain  a  list  of  words  of  forum

sections where the program should post the message (will not work with ZLinksList, RLinksList
and ELinksList).

The example: 
It is necessary to post message on subject such as Real estate. 
For this purpose follow these steps:
1. Click Load defaults 
2. Type at the top of the default list words that are relevant to your subject (the register of letters

makes no difference):
   

  The real estate
  To lease
  To rent
  Rent
  Lodging
  Apartment 

Therefore,  the program will  post  the message in  those sections of  forums,  which correspond to
needed subjects. If any of listed topic words are not found in forum, then XRumer will post to the
default topic, such as Offtopic, Flame, Flood, Advertising, etc. If those topics are not found, then it
will post on the most visited topics. 

6. Preview in browser 
By clicking the Test button you will see how your message will be on forums (the forum type can
be chosen from 4 most prevalent variants - phpBB, Invision Power Board, vBulletin, YaBB).

1.4 Interface sleep mode

After 5 minutes of inactivity, interface of XRumer will go in sleep mode. At sleep mode all actions
(posting, proxies update, email activation, etc) are NOT stopped. The only action stopped is visual
interface. It is necessary to use this option to reduce usage of CPU and RAM. Due to it, the speed and
stability of posting are increased.    

Just moving mouse and sleep mode goes inactive. 

To turn off "Sleep mode" open xuser.ini file, in Section: "AdvOption" add "EnableSleepMode=0"
(without quotes)
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1.5 Files structure

Folders:
Debug/ - Here is the log of single test forum processing, after pressing Test button
img/ - In this file is stored graphic information 
Langpack/ - Language packs. 
Links/  -  Here are stored all  databases, which contain links to forums, guestbooks, blogs etc. Files

format: LinksList id*.txt, where * is an ID (database's number). 
Logs/  -  this  folder  contains  report  files  (reports  are  automatically  created  during  the  work  of

program)
Plugins/ - the folder for plugins
Projects/ - folder for your projects. Files format: *.xpy  or *.xml
FieldsForAI - the folder for data from sealf-learning system 
DeCaptcha - the folder for user's DLL-libraries (files *.DLL) for Graphic captcha decoding

Files: 
config.ini – the program configuration file
proxy.ini – Proxy checking settings
xblack.txt – black list (forums where posting is undesirable) 
xprior.txt – contain forums default categories, where are recommended to post messages 
xproxy.txt – contain HTTP – proxy list. It is updated automatically or the user fills in it.
xsocks.txt - contain SOCKS – proxy list. (must be filled in by the user) 

About the control files that affect the posting algorithm read here. 

Types of links databases 
There are 5 types:
LinksList id*.txt –the main database. 
ZLinksList id*.txt – a database formed during the last session of posting through LinkList database.
The links stored in this database point directly to the page where message is posted.  
MLinksList id*.txt – the database with activation links, formed during the downloading of activation
links  from  the  e-mail  inbox  (it  is  created  if  in  Profile  activation  via  email  option  is  set  up  manual
mode).  
RLinksList id*.txt – the database with links to use for Reply option on forums. By using this option
you can reply to your previous posts.It is used for Question-answer system.  
ELinksList id*.txt – the databases for editing previously created posts.

More detailed about type of database read here.

1.6 Tools

The  program  has  a  big  number  of  useful  tools  built-in  (for  example  a  tool  to  work  with  links
databases). They can be accessed through the menu at the top of the main window. All  tools are
working in demo-version also.

1. Links counter - by clicking this menu a window will appear, allowing you to choose the needed
file. Choose the required database from the Links folder and XRumer will tell you the exact number
of links in that database.

2.  Links  post-processing  -  change  the  form  of  links  in  the  selected  database  into  their  index
condition  (for  example  links  looking  like  this  http://link.com/index.php?...  are  changed  into
http://link.com/index.php). 
Attention:  This tool  is useful  only for forums. With guestbook, blogs, links catalogues and others
the tool will not work. To set up this tool use Option > Advanced options.

3.  Delete  all  links  according  to  black  list  -  after  clicking  this  menu  you  choose  from subfolder
Links  which  file  to  process.  Program  will  delete  all  links  in  chosen  database  according  to  the
black-list (which is stored in the xblack.txt, located in main folder). At the end of filtering, all removed
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links are automatically located in the file blackfiltered.txt of the program's root folder.

4. Delete duplicated links  – program deletes all  duplicate links with the same hostname (except
the first one) from the selected database. To set up this tool use Option > Advanced options.

5.  Filter  links  by  domain  zone  -  choose  database,  then  select  domain  zone,  for  example  .su
(without  brackets).  All  links  with  domains  matching  with  *.su  mask  will  be  deleted.  This  is
convenient  when  for  example  you  want  to  remove  all  Russian  language  forums  from  an  English
language base.

6.  Sort  Success id*.txt  by topic number  -  selected  report  file  of  successfully  posted  messages
(located  in  Logs  file)  will  be  sorted  by  topic  number  in  descending order.  At  the  beginning  of  list
there will be the most visited forums.

7. Links database analysis - this is a powerful tool that can be used for a number of tasks. Most
useful ones are:

- To check on which sites the message was successfully posted and count the percentage of
deleted topics by moderators.

- To select forums by their subject

Usage:
1. In Source  field enter the file to be analyzed. If  it  is a links database, it  will  be located in  Links
folder, if it is a Success report - in Logs folder.
2.  In  Search  field  enter  the  words  and  phrases  for  search.  If  Search  in  =  Content  option  is
selected,  the  search  will  be  done only  on  those  sites.  If  Hostnames  option  is  set,  search  will  be
done only on domains of links and will take seconds.
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3. Click Start
Results are stored in file set in the Dest field.

Examples of search queries:

my site
cool site
- in this case phrases my site and cool site will be checked for presence (without brackets)

my site
cool site
- in this case words my or site or cool will be checked for presence (without brackets)

mysite.com
- in this case mysite.com will be checked for presence (without brackets)

Take into consideration that with analyzing of reports files, the results will be only the approximate,
because in reports files not all links lead directly to posted message (for example, on some forums
they lead to forum categories).

8. Links database filter - universal tool for processing links databases and report files. 

It’s a very flexible filter which you can use for many different tasks. Processing speed of base from
500 thousand links – will take no more than 1 second. In Filter-words field can be used words or a
file with filter words per line.
The tool is extremely simply to use.

Some examples:
It  is  necessary  to  allocate  all  links  from  Success  id1.txt  report  file,  where  the  word
Registered is NOT included:
 
1. In field Scr. Base select Success id1.txt  
2. Deselect checkbox Use filter (if it is selected)  
3. In field, Filter-words type registered (without quotes).  
4. Select the option Entire line from drop down menu Search scope, and Remove option.  
5. Press Start  
Results will  be saved in file (Success id1.txt) indicated in Res.base  field,  and will  contain links on
forums where the message was sent without registration.  

It is necessary to selecte all links from ForumList id1.txt database with domains zones .ru,
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.ua, .kz, .by, (Russian resources):

1. In field Scr. base select LinksList id1.txt  
2. Deselect checkbox Use filter (if it is selected)  
3. In field, Filter-words type .ru, .ua, .kz, .by (without quotes).  
4. Select the option Domain zone from drop down menu Search scope.  
5. Select Remain, remove others  
6. Press Start  
Results will be saved in file (LinksList id1.txt) indicated in Res.base field, and will contain links only
to Russian-language resources.

It  is  necessary  to  filter  LinksList  id1.txt  file  after  posting,  leaving  only  links,  where  was
posted the message:

1. In field Scr. base select LinksList id1.txt  
2. Select checkbox Use filter (if it is not selected)  
3. In field Res. base select the report, created after posting : Logs/Projec_name/Success id1.txt.  
4. Select the option Filter-database  > Are present in filter database.  
5. Press Start  

9.  Links  patterns  analysis  -  the  tool  for  automatic  analysis  of  reports  and  links  databases,  to
reveal most often met attributes (patterns) of links. To see results is possible in 3 ways: text, table
and  diagram.  This  tool  allows,  not  only,  to  analyze  databases  and  reports,  but  also  to  form
automatically databases of queries for parsing search engines.
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 Analysis area - part of link, which is analysed. It's either only path, or only file name, or path +
file name.
 Report format - the form how will be shown all gathered links patterns: XRumer pattern (with

use [...]), or inquiries format for Google (for gathering similar links), or PHP regular expression.
 Export to file LinksReport.txt - if enabled, at the end of analysis, the results will be saved in

LinksReport.txt file.
 Show count in text - quantity of pattern hits in database in the Text tab (switch off this option if

you wish to copy results for the further work)
 Ignore patterns with index. - will be analyzed only those links, which don't contain index.. 
 Restrict report for ... patterns - limits of lines (patterns) in the report file. In analyzed database,

the list is always sorted on popularity decrease.
10. Links converter (HTML/BBCode + anchors) - the tool for fast generation or conversion of links

format.
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- Choose a pattern (mask) according to which links will be generated, 
- Choose the desired format and generation method,
- Fill the list of links and anchors, and press button  Generate . 
The list of links will be generated in  Result  block.

11. Graphics reports - this tool allows to receive graphic display of distribution (in percentage ratio)
of successfully posted messages from database, of links waiting activation, and also domain zones,
forums engines and guestbooks. To begin the distribution, press the button Load DB and reports. It
is recommended to use this tool, after full dispatch, when all reports of current links database are
already generated.
There are two kinds of displaying mode - in graph form and in diagram form (see screenshots below).
The graph gives approximate representation about distribution. The graph and the diagram are freely
scaled at change of form sizes .

The note: the screenshots below have been made after the dispatch by unchecked database of
1.400.000 links. 
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 Graph  form  representation:  if  in  current  project  the  dispatch  in  chosen  database  was  ended
(partially  or  a  strip),  you  will  see  two  curves:  green  -  distribution  of  successful  posts,  blue  -
distribution  of  forums  waiting  activation.  Other  curve  distributions  can  be  enabled/switched  off
manually, by choosing corresponding items in   Domains zones  and Engines blocks.

 Diagram form representation : here, it is possible to see the total contents of chosen elements
from database. Horizontal columns show percentage of, and on the right, it is shown absolute
quantity in database.
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1.7 Traffic saving algorithm

This algorithm is added into the program since 4.0 version

The purpose of algorithm: during posting, the program adds a special meta-information in
ZLinksList database. In this database are stored some services data, like: what part from each page
should be downloaded, which pages should be downloaded and where is enough to get only page
header. Thus, in all subsequent dispatches (if ZLinksList mode is chosen) this information will be
used for more optimal traffic saving: because the program will download only necessary information.

The positive side: reducing dispatch time approximately 3 times and more, in comparison with usual
dispatch through ZLinksList, reducing spent traffic, percentage of successful posts is increased.

The negative side: after a while, generated meta-information can become outdated, since
administrators of forums and guestbook could do some changes on their resources: to add obligatory
registration, pre-moderation, additional protection, to change design etc.  

T.S.A. usage:
1.) Enable this features in Option>Advanced options.
2.) Make full posting through LinksList database.
3.) After dispatch will be finished, create a new project (with other values in fields Nickname, E-mail,
Topic, etc.)
4.) Delete duplicates from ZLinksList (the database is located in Links folder) using Delete
duplicated links tool. 
5.) In Links database tab choose ZLinksList mode. 
6.) Press Start button.

ATTENTION: It is not recommended to use T.S.A. for :  Question-answer  system, post-editing
system, and also for posting in only registration and from earlier registered user modes.
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2 Program settings

Immediately after installing XRumer has optimal set up. But you may need extra configuration: turning
on anonymity parameters, speed / success rate, and so on.

 Proxy checking settings
 Speed & success rate
 Advanced options
 AntiSpam System
 Profiles activation via e-mail
 Tools set up
 Hidden settings

2.1 Proxy checking settings

This option is available through menu: Options -> Proxy options settings
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Proxy connection type:  select the type of proxy HTTP or SOCKS. By default  are selected HTTP
proxies. This type of proxies has 2 significant flaws - usually they are slow, and don’t provide 100%
anonymity. 
SOCKS, on the contrary, provide better anonymity and faster data transmission, but they don’t work
in some European countries (ISP providers close most of ports used by SOCKS).

Check through SOCKS45: anonymity checking will be through set up SOCKS- address

Server timeout (sec.): maximum time of response of proxy / SOCKS to the request. The lower this
setting is, the higher speed of proxy / SOCKS will be after checking, but total number of proxy will be
less.  

Number  of  threads:  Number  of  parallel  threads,  which  check  HTTP-proxy  /  SOCKS  .  This
parameter should match with capacity of Internet connection.

Checker  script  address:  checking  for  anonymity  is  made  through  a  remote  address.  On  this
remote address is installed a script for proxy checking. You can use our server (is set up by default),
or  you can use your server or site. To do that you need first to upload the proxyc folder to any of
your server or site (proxyc is the script that checks if the proxy is really anonymous and it's located
in main folder of XRumer proxyc (Proxy Checker)). Enter the URL to script in this field: 

Delete duplicated proxies:  if it's enable, duplicated address (ip:port)  of proxy and SOCKS will  be
filtered during collection.

Do  not  check  for  anonymity:  If  you  have  set  up  XRumer  to  collect  HTTP-proxy/SOCKS  from
already verified sources, it's recommended to enable this option. 

Enable  autorefresh:   this  option  turns  on  automatically  updating  and  checking  of  HTTP-proxy  /
SOCKS with set up periodicity. 

When anonymous proxies count is reached to: ...  - then stop refresh:  here is set up maximal
number of HTTP-proxy/SOCKS

Time of file storage: during this period of time the program considers each HTTP-proxy/SOCKS as
working proxy. 
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Proxy list refresh regularity: update frequency. If it's enable - the program will autoupdate the list
of proxy. 

Path and files: the path to files where are stored checked HTTP-proxy list and SOCKS.

2.2 Speed & success rate

This option is available through menu: Options -> Speed <-------> Success rate

Express setup 

 Changes of this parameter will affect all parameters from block "Fine tuning", either increasing the
speed of dispatch, or increasing the success rate (the proportion of successfully sent and placed
messages and registered profiles). 

Fine tuning 

Maximum size of  loading page,  Kb  -  sets  maximum size of  the page that  will  be  downloaded.
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The parameter should be lowered when posting is to overloaded guestbooks or blogs.

Maximal URL’s count per page - this option is limiting URL’s quantity from loaded pages. If you
are posting in guestbooks, topic creation link goes right at beginning of page, then is meaningful to
reduce this  value  till  30-50.  If  on  those  resources  where  the  topic  creation  links  is  at  the  end  of
page - it is recommended to increase up to 400-500.

GET-query  waiting  limitation,  sec.   –  sets  maximum time  for  program  to  wait  after  sending  a
GET-query to server. If  your reports  contain  a lot  of  Get-timeout  errors,  you should increase this
setting. On the other side, if you have a fast connection and you are not using proxies - it is wise to
decrease this setting to make posting process faster.

POST-query waiting limitation, sec. - similar to the previous option. This setting should be set to
substantially higher value than the previous one, because POST-queries usually take longer for the
site to process

Express-posting  mode  -  special  mode,  during  which  the  posting  process  is  sped  up.  The
speed is increased because program will not wait for the forum to reply and will follow the redirect
link. However, it is not for sure that the message was posted, therefore it is recommended to use
this  only  on  previously  checked  databases.  It  is  recommended  to  post  onto  guestbooks,  not  on
forums.

Try query again if timeout  - if enabled, the program will do additional attempts of inquiries at
occurrence GET-and POST-timeout. It will slow down a little the dispatch, but will raise percent of
successfully posted posts.

Frames processing - if enabled, program will process contents of pages that are inside <frame>
and <iframe> tags (excluding banners, adverts and such). It is recommended to be turned on for
sites with a lot of navigation inside frames.

Enable traffic saving algorithm - In this mode  ZLinksList base will be formed with addition
of  special  meta-information, which will allow subsequently to accelerate posting.

Option captcha recognition 

 Max. attempts to decode captcha - the number of attempts to decode graphical decaptcha from site
at registration and at sending of message (if such protection exist on site). To make a new attempt to
decode captcha, the software should know that previous attempt was unsuccessful. XRumer
understand it from inscription "Value entered is invalid" from file xmessages.txt in block PICTOTRY.
This parameter can be changed at your choice. For some easy captcha it's enough 1-2 attempts to be
decoded. For other more complicated up to  3-4 attempts. For most complicated even up to 10-20
attempts.  

Examples: 

This captcha is decoded from 1 attempt (100% decoded)

This captcha is decoded from 2-3 attempts (40% decoded)

This captcha is decoded from 5-10 attempts (20% decoded)
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  Automatic mode - The software will decode captcha in automatic mode (will use internal and
external DLL , if they exist)   
  Semi-manual mode - XRumer will use automatic and manual decoding. The software will try to

decode captcha automatically, if all attempts   will be unsuccessful it will show the captcha for
manual decoding.  
 Usage of Anti-Captcha services  - decoding captcha using the service Anti-Captcha.com. You

need to have an account there and load money to your account. To set up the work with this service
edit the file AntiCaptcha.ini. In field “Key=” enter the Your key from Anti-captcha.com service. The
key you’ll find in your account on site in Settings menu. In case, if you do posting on sites, where
XRumer can’t recognize the captcha, is recommended to set in “Speed&Success rate” menu the
parameter  “Maximal attempts to decode capthca=0” , the image will be sent immediately to service
for decoding. If the parameter “Maximal attempts to decode capthca=" is different, then XRumer, as
in semi-manual mode will try to decode captcha (when the software sees that potentially it's possible
- it mean the program known this type of captcha)  and only after unsuccessful attempts will send
the captcha to service for decoding. 
  Usage of CaptchaBot services  - decoding captcha using the service http://captchabot.com/

(analogically, the setting are saved in CaptchaBot.ini file)  

2.3 AntiSpam system

These settings are in Options > AntiSpam System
AntiSpam System is made for a smart submitting: to gather a database of links with thematic threads
with instant submitting or for a later submitting of your message.

Parameters for reply selection

http://antigate.com/
http://captchabot.com/ru/register.html?ref=6c818b4a6f7f602d6aead2741b204c7b
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1.   Min. thematic  level (from 0 to 100%) - of thematic level depends how much the reply will
correspond with chosen theme. The closer to 100% - more thematical will be the reply.  As higher will
be this parameter as harder will be for XRumer to find proper reply. As result the success rate will be
lower. Same will be lower the submitting speed, because the program will take longer to search for
correct (more thematic) topic. Therefore: 

lower lever - hits is lower, speed is higher 
higher level - success rate and speed is lower 

2. Max. post similarity (from 0 to 100%) - maximal level of similarity,  to ensure that the program will
not send into the topic, message text that has already there.

3. Min. words in reply - number of words in reply. The phrase with minimal number of words, XRumer
will not use in replies.

4. Max. words in reply - The phrase with maximal number of words.

Working mode

1. Turn off - program will work in standard mode, AntiSpam System will not be activated. 

2. Collecting information for reply - will turn on preparatory step: the software will gather information
for reply. In mean time, submitting, registration etc. will not be made. Software only read the content
(topic name and threads). Gathered information is saved in AntiSpam\nodes.txt file. To process to
next step the size of nodes.txt file should be at least 100Mb (recommended file size - more than
400Mb).

3. Posting of thematic replies - the main mode of AntiSpam system. To work properly this option,
first need to register accounts on forums. Then from Advanced Options choose "Posting on behalf
of a previously registered user", and select this option. The software will submit thematic replies on
forums where account was earlier registered.  

4. Add in the post text from project - to each post, will be added the text from Your project. It's
recommended to start the message from project with words: "by the way ...", "it's not offtop, but ..." etc.
The text message can contain links or other information. 

5. Insert link from project in keywords - the link from field "Homepage" from project will be inserted
in keywords. These keywords are listed in section [words]...[/words] (separated by commas) in Text
field.

Example:  Your site is http://my-car.com . The theme of your site is car. In "Homepage" field you enter
the link http://my-car.com and at the end of your message text from project you add
[words]car,sedan,bus,automobile,vehicle[/words]. 
As results, under words listed in posts, the software will insert your link using BB-code:
...[url=link]keyword[/url].
Also it's possible to set up several domains:
[words]car,sedan,bus,automobile,vehicle,url=http://www.yahoo.com,search,Yahoo,find,found[/words].
In this case, for first list of words (car,sedan,bus,automobile,vehicle) the link will be used from
"Homepage" field , and for second list the link - http://www.yahoo.com. During the posting the software
will save in Success report links to forums where the link was inserted under keywords.

6. Use neutral phrase - if it's enable this option the program will send short neutral phrase, in case it
will not find suitable reply. You can read more details here. During the posting the software will save in
Success report forums where was used as reply a neutral phrase.

2.4 Advanced options

 These settings can be accessed through menu: Options > Advanced options
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Posting
1. Registering only  (without posting) -  if  enabled, the program will  register in all  forums, but will
not send any messages.

2. Mandatory registration with posting – before posting the program will register at forums, even
if it is possible to leave the message without registration. 

Attention!!! 
It is not recommended to use this option, if you are not planning to use mass post-editing 

3.  Posting  on  behalf  of  a  previously  registered  user  -  makes  it  possible  to  carry  out  more
effectively advertising actions. In this mode, XRumer will post under a name of the user which was
registered at forums during the previous posting. 

IMPORTANT!!! 
In the current project  nickname and password should remain the same. Throughout posting,
the program will not register a new, and will login at once.
Following  modes:  Registering  only,  Mandatory  registration  with  posting,  Posting  on
behalf of a previously registered user are designed for working only with forums.

4. Aggressive posting mode - Topic will be created on forum on as many categories as possible.
This option work only on some versions of forums (phpBB, VBulletin, YaBB, IconBoard, IPB) and
only in LinksList mode. 

5. Auto resumption - if enabled, XRumer will start posting automatically after it's launched.
 

6. Enable checking for active links after posting - XRumer will check for active/alive links after
posting. 

Remember: you need this option enabled if in posted message you use links (correct format
: http:// ). 

Do not use this option when you are posting in ZLinksList.  

IMPORTANT!!! 

http://
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If  the  format  of  link  is  incorrect  (without  http://)  in  fields:  Homepage,  or  Message  text,  or
Signature then the option will be set up to 0 automatically.

7.  Editing  profile  after  registration  -  if  it's  enable,  the  software  will  edit  the  profile  after
registration.  It  will  full  fill  additional  fields  that  are  not  available  at  registration  as:  Homepage,
Signature etc (these fields are not available at registration on such forums as: IPB and VBulletin.
So  it's  important  to  enable  this  option  on  posting  through  these  type  of  forums.  The  chance  of
posting links will be higher.) 

8.  Load  avatar  at  profile  editing  -  if  this  option  is  enable  then  the  avatar  will  be  picked  up
randomly from folder "img\Avatars\" and uploaded at the editing of profile.

9.  Log  in  from  current  account  ,  if  username  is  used  -  if  it's  enable,  and  at  registration  the
software will  get  the error  "the login/email  is  already  used",  then  it  will  log in  with  username and
password used in project file (it  means the software will  assume that it  was previously registered
on this site).

 
10. If the BB-code is off, convert it to HTML - if this option is turned on and in sent text is used
BB-code  (links  look  like  [url=http://link]link_text[/url]),  then  for  resources  that  do  not  accept
BB-code (guestbooks, message boards etc.) everything will be automatically converted to HTML:  
[url=http://link]link_text[/url] - into <a href=http://link>link_text</a>,   
[b]...[/b] - into <b>...</b>   etc.

11. Enable refspam - if it's enabled this option, each first inquiry to the link from database will be
done by indicating Referrer =  homepage from your project.      

12. Only refspam, without posting - The program will do query to the page from database and to
all links to which this page refers, indicating Referrer = homepage from your project. Messages will
not be posted. 

13.  Ref-queries number per URL: - regulate the number of queries with indication of Referrer url
from homepage filed of project (if it's enable to use proxies, each ref. query will be made through
unique proxy/SOCKS):
 - If less than or equal to 1, the program collects all the internal pages of URL, and sends a single
ref-demand, also on index page.
 - If more then 1, then the specified number of times XRumer will send ref.queries only to indicated
page

 

Interface

1. Autolaunch on exit - if this option is checked, then the program will reopened automatically if it
was closed accidentally.
2. Visual effects - enables or disables visual effects (such as flowing of the window etc.).
3.  Monitoring  -If  is  enabled,  at  the top of  program window in  one line will  be shown the  current
queries through the Internet.  
4. Do not save options - if enabled, settings will not be saved when program is closed.
5. Hide logo - hides the logo at the top of the program window. This is particularly effective when
used on remote servers or VPS.
6. Hide tread monitoring table - Hides the display of treads during posting. It is recommended to
use during posting for stability and speed increase of the program.
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On pressing "Start" button

When  you  start  posting  from  the  beginning  of  the  forums  database,  you  will  probably  need  to
delete  old  reports.  If  you  turn  on  the  following  options,  then  the  old  reports  will  be  deleted  after
restarting.
1. Delete old logs (Success, Halfsuccess, ...)
2. Delete current Z-, R-, E- and M-database

Special conditions of anonymity

1.   Do not post without proxy – if enabled, you have 100 % guarantee that your messages will
be posted only with use of a  proxy.  Before including this  option,  enable Use proxy  option in  the
Anonymity tab from main form of the program. 
2.   Allow to post without proxy to prior. categories - if it enable, this setting will make posting
process  faster  (if  the  level  of  anonymity  is  non-critical).  In  this  case,  XRumer  will  find  out  the
section suitable under the priority list (which it is set in the project) the posting at current  forum will
be without proxy. 

Reporting

1. Detailed reports (Results:) – if enabled, each link in Reports files will be commented.
2. Save to Z-base links, which requires activation  - in database ZLinksList id*.txt will be saved
links to sites where message was successfully posted, also links to all sites where registration was
successful and was sent email activation.  
3. Make log of list of categories (CategoriesLog.txt) – if this option is enabled, the program will
log categories list on forums (as on those where message was posted, as on all others). Log file:
Logs/CategoriesLog id*.txt

Tools options (Mass PM options)

1. Max. users count  - maximal number of users to scan for the presence of PM links (send
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personal messages). Gathered links are saved in MassPM folder, so at the next MassPM process,
speed will increase.
2. Max. PM limit - maximal number of PM's per 1 Forum.
3. Min. pause per message - pause between sending of new PM. This will help to avoid suspending
of account on forum.

Default button resets all options to their default values.

2.5 Profiles activation via e-mail

XRumer can activate automatically the profile by email. This has to be done for forums that require
after registration to activate account. 
 
It works 2 ways of activation (Options menu → Profiles activation via e-mail) 

1. Automatic mode (it is recommended for use) 
In  this  mode  there  is  automatic  activation  running  in  background  (without  user  participation)
through specified time intervals. The process is displayed in Mail tab of the main form of XRumer.
If in this mode activation takes too long and doesn’t activate - probably, the data of mail box are
incorrectly  specified  in  the  project  (for  example,  the  mail  server  does  not  allow  to  download  the
letter under the pop-report)  

NOTE: in this mode, creation MLinksList database is not made, as activation is made directly at
once after reception of mail.  

 
2. Manual mode.  
After  going  through  the  LinksList  id*.txt  XRumer  is  switched  into  the  mode  of  downloading  the
activation links. It gets the e-mail from the address specified in the project file. This has to be done
for forums that require you to follow a link sent to your e-mail to activate your account.  
After  all  the  links  from your  e-mail  inbox  (the  number  of  mail  in  the  inbox  is  not  the  number  of
activation  links,  there  are  also  greetings  and  other  messages  from  forums)  the  program  starts
sending your message to the forums, meanwhile activating your account in them. 

3. Disable  
Account activation by e-mail will not be made. It is meaningful to choose this option if the posting
are making only in guestbooks / blogs. 

NOTE: If the email used in project apply a nonstandard POP port to download the emails, then
this port should be set up in xpop.txt in the field [PORT] 

IMPORTANT!!! 
Before starting a new posting project check through a browser (Internet Explorer or other), that: 

1 specified in the project, email address is available on the specified data 
2 it is possible to uploading letters under the POP3-report
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3 this email is not used before in previous dispatches 

Check email every... :  This parameter specifies frequency of requests for downloading emails.
This option will work if it is selected automatic mode.

Download email at the end of submitting: also work in Automatic mode. If it is enable,at the end
of posting XRumer will connect to mailbox and do activation of links. 

 

Download all emails, without filtering by header: if it's enabled, checking for activation link will be
made in all emails, not only in those from xpop.txt (but it will take the time) 

2.6 Tools set up

This option is available through menu: Options -> Tools set up

.

These settings affect the work of built-in tools for working with database (see Tools menu) - instrument
Links post-processing  and Delete duplicates 

2.7 Hidden settings

Some settings are not entered in program visual interface. To make changes is possible, only, by
editing xuser.ini file (sections [AdvOptions] and [Settings]). All changes made will be available only
after restart of Program, if xuser.ini file was edited during the work of XRumer. 

It is strongly recommended, to make changes in xuser.ini file only when

XRumer is closed! 

This option is available only beginning with version 4.0 and later: 

ManualDecaptcha= - option to enter manually graphic captcha. If this option is enabled the program
will try to decode captcha (as usually), in case if the number of attempts will reach maximal limit, the
software will offer to enter captcha manually. It will pop up a window. The posting process will not stop.
Captcha entered manually will be added in self-learning system of the software.

ManualDecaptcha=0 – XRumer will use only automatic decoding
ManualDecaptcha=1 – XRumer will use automatic and manual decoding
ManualDecaptcha=2 – decoding captcha using the service Anti-Captcha.com. You need to have an

account there and load money to your account. To set up the work with this
service edit the file AntiCaptcha.ini. In field “Key=” enter the Your key from
Anti-captcha.com service. The key you’ll find in your account on site in
Settings menu. If you do posting on sites, where XRumer can’t recognize the
captcha, are recommended to set in “Speed&Success rate” menu the
parameter  “Maximal attempts to decode capthca=0” , so the image will be
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sent immediately to service for decoding. 
ManualDecaptcha=3 – decoding captcha using the service http://captchabot.com/  (analogically, the
setting are saved in CaptchaBot.ini file)  

HideProjectMenu= - option to hide Project menu 
HideProjectMenu=0, then menu Project will not be hidden. 
HideProjectMenu=1, then menu Project will be hidden (after restart). 

CheckForActiveLink= - option of checking for active link after posting; 
1 = to check; 
0 = not to check. 

If in message text there are links with http://, then enable this option (CheckForActiveLink=1).  Do not
use this option in express posting mode and through ZLinkList. 

IMPORTANT!  
In case if link don't have right format (http://)  in Homepage, Signature and Message text fields, then
CheckForActiveLink= will goes 0 automatically. 

CheckPostLevel= - checking level of link post. It is working only if CheckForActiveLink=1 . 
If it is CheckForActiveLink=0, then XRumer will check the link in server response after posting the
message. 
If it is CheckForActiveLink=1, then XRumer will check also on page with sending form.
If it is CheckForActiveLink=2, then XRumer will check all internal pages. 

ThreadsLowNumber= - indicate the number of treads that will be used while XRumer is downloading
email activation if in email box are more than 500 emails. By default, there are 5 treads.

PriorSortMethod= - the method of choosing the topic on forums,  if in list of priority categories this
category is not available.

0 - it will choose most popular category (by number of topics) 
1 - it will choose category with lowest popularity. 

This option work only on some versions of forums (phpBB, VBulletin, YaBB, IconBoard, IPB) and only
in LinksList mode. 

AggressiveMode= - aggressive posting mode on forums. Topic will be created on forum on as many
categories as possible. 

0 - disable aggressive mode
1 - enable aggressive mode 

This option work only on some versions of forums (phpBB, VBulletin, YaBB, IconBoard, IPB) and only
in LinksList mode. 

DecaptchaMode= - mode for graphic captcha decoding. 
Internal functions - XRumer's standard methods of graphic captcha decoding.  
External functions - user's functions from DLL-libraries which are in folder DeCaptcha.

0 - it will not use neither internal functions, rather external functions (exceptions are the simplest
protection of composite image)
1 - it will use only internal functions
2 - it will use only external functions
3 - priority for internal functions,but if captcha is not decoded -then it will be used external function
for this tread.
4 - priority for external functions,but if captcha is not decoded -then it will be used internal function
for this tread.

DownloadEmailOnFinish= - This option work with email activation in Automatic mode. If it's enable
then XRumer at the end of database will download and activate the rest  of emails. 

0 - will finish the submitting without downloading and activating the rest of emails.  
1 - will download and activate the rest of emails. 

EnableSleepMode= – Turn on/off of sleep mode 
0 – turn off
1 – turn on

http://captchabot.com/ru/register.html?ref=6c818b4a6f7f602d6aead2741b204c7b
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 ProjectGraphicsInterface= - turn on/off graphic interface of window for project editing. To turn off
this option can be necessary for faster project editing through a remote desktop.
 0 – turn off the background graphics of project editing window

1 – turn on 



Part
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3 Databases types

  LinksList
  ZLinksList
  RLinksList 
  MLinksList
  ELinksList 

3.1 LinksList

The standard database type (enable by default). LinksList does NOT mean, that in database there
should be only forums. It is conditional.

 Format of files names: Links/LinksList id*.txt, where  *  - database identifier, is indicated in Links
database tab. . 

3.2 ZLinksList

This  database  was  formed  during  the  session,  going  through  LinksList  and  MLinksList
databases.  The  process  in  this  mode  is  a  few  times  faster,  because  the  links,  stored  in  this
database, point directly to the page where message is posted. 
However,  if in database the basic part are the forums waiting obligatory registration, the effect of
acceleration practically will not be.  

Format of files names : Links/ZLinksList id*.txt, where  *  - database identifier, is indicated in Links
database tab. 

3.3 RLinksList

This  database  was  formed  during  the  session  going  through  the  LinksList,  ZForumList  and
MLinksList  databases.  It  holds  direct  links  to  the  respond  pages  of  the  previously  posted
messages in forum (if applicable). Posting in RLinksList under other nickname (it is necessary to
change the e-mail also) is possible to create a virtual dialog and to answer between two or more
aliases.  

The purpose of Question-answer system is:
1.  Post  the messages through the LinksList  with  the text  containing questions (for  example,  with
request to recommend a site on any subject)  
2.  Post  the  messages  in  created  RLinksList  database  with  the  text  containing  answers  (for
example, with recommendation of a promoted site). At editing the project, do not forget to change
Nickname and Email fields, or select the mode from Options→Advanced options→Posting on
behalf of a previously registered user.

   Format of files names: Links/RLinksList id*.txt, where  *  - database identifier, is indicated in Links
database tab. 

3.4 MLinksList

 The database with activation links, formed automatically upon downloading activation links, from
the  e-mail  inbox  (it  is  created  ONLY  if  in  Profile  activation  via  email  option  is  set  up  manual
mode). The activation links come from those forums on which email activation is obligatory. During
the posting in this database XRumer perform profile activation and topic creation. The topic will not
be created if only registration mode will be enabled.
 
Format  of  files  names:  Links/MLinksList  id*.txt,  where   *   -  database  identifier,  is  indicated  in
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Links database tab. 

3.5 ELinksList

 
ELinksList  database  is  formed  automatically  during  posting  by  LinksList,  ZLinksList  and
MLinksList. In this database are saved links for future editing of earlier created topics. By posting
in ELinksList database, XRumer will not create new messages on forums, but will  change texts
and headings from earlier created messages specified in this database.
 
It  is  necessary  to  remember,  that  in  this  database  are  those  forums  which  the  program  had
registered earlier. In ELinksList database it is necessary to post with the same username and the
password which was used in previous posting.

Therefore, if  you  wish  in  future  to  edit  the  posted  messages through ELinksList  database,  it  is
necessary  to  select  from Option→Advanced options→ Mandatory registration  with  posting
mode.

Format  of  files  names:  Links/ELinksList  id*.txt,  where   *   -  database  identifier,  is  indicated  in
Links database tab. 
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4 Description of work

o  Posting process  
o  Posting modes
o  Anonymity
o  Scheduler
o  Self-learning
o  Mass PM 
o  Working with e-mails 
o Capcha decoding 
o Text capcha decoding 

4.1 Posting process

During the work XRumer processes step by step links from forums database – LinksList id*.txt
(or ZLinksList id*.txt, MLinksList id*.txt, RLinksList id*.txt – see Posting modes).  

The algorithm of work is: 
  
1. The program access the site processing link by link from the database. 

2. If it is a forum, it chooses the most suitable topic for your message. 
If it is not – it looks for a link to blog/guestbook/links catalog/creation of new topic etc.

3.  The  program checks  if  registration  is  needed to  create  topics.  If  registration  is  obligatory  –  it
registers to the forum, and logs into it after that. If during registration there is a need to enter a text
from a picture (pictocode) – the picture is downloaded and processed, and the code is entered.

More info on this process is located here - http://www.botmasternet.com/pictocod/. 

If registration must be activated by an e-mail, the program will continue working on next forum and
activate  links  on  background,  if  Profiles  activation  via  e-mail  is  set  in  automatic  mode.  If  is
turned off – it will stop work on this forum. If Profiles activation via e-mail is set in manual mode,
then  it  will  download  activation  links  from  the  e-mail  inbox  only  by  pressing  the  button  Get  the
activation  links  from  the  mail  box  in  Mail  tab.  This   forum  will  be  placed  in  the  report  file
Activation id*.txt. Downloaded links are placed into the MLinksList id*.txt database. 

4. Find the form that has to be filled in and fills in the needed fields.  

5. Sends the entered data.  

6.  Checks whether the information sent was actually posted. If  it  was – link to the page with the
message is added to the Success id*.txt report. If data was sent but the software could not verify
the posting - link to the page with the message is added to the HalfSuccess id*.txt report. 
The link to  the page where message posting has occurred is  placed into the  ZLinksList  id*.txt
database and if next time the process is launched not by the LinksList id*.txt database but by the
 ZLinksList  id*.txt  database it  will  run 5-7 times faster.  The link to  the page where  the  reply  to
that message is posted is placed into the RLinksList id*.txt database. And next time you start the
messaging from this database, no new topics will be created, instead replies to previously created
topics will be sent.
This  is  the  Question-Answer  system  (more  info  on  this  is  located  here  -
http://www.botmasternet.com/v-o/).  

7.  If the link to the form or the forum has not been found, the link is placed into the Resultates
id*.txt report, with the explanation why the posting failed.  

8. If  Profiles activation via e-mail  is  set  in  automatic  mode,  the program will  continue working

http://www.botmasternet.com/pictocod/
http://www.botmasternet.com/v-o/
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and activate links on background. 

If  Profiles  activation  via  e-mail  is  set  in  manual  mode,  when  the  end  of  the  LinksList  id*.txt
database is  reached,  only  by  pressing the  button  Get  the  activation  links  from the  mail  box,
XRumer  will  switch  to  downloading activation  links  from the  e-mail  inbox.  Downloaded  links  are
placed into the MLinksList id*.txt database. When the download is complete it goes through the
activation links.

Note: all databases are stored in the Links folder, reports in Logs folder.

4.2 Posting modes

Posting mode is selected on the Links database tab. There are 5 modes:

1. LinksList – links are taken from the main database. 
2. ZLinksList – links are taken from a database that was formed during the last session when

going  through  the  main  database.  The  process  in  this  mode  is  a  few  times  faster,  this  is
because the links stored in this database point  directly to the page where message is to be
posted.  

3. MLinksList – the database with activation links, formed during the downloading of activation
links from the e-mail inbox (see Mail).  

4. RLinksList – the database with links for answering to in previously created topics.  
5. ELinksList – the databases with links to editing before created topics. It is necessary to post

necessarily  with  same  nickname  and  password  that  was  previously  used.  Probably  to  edit
only those topics that were created on behalf of the registered user.

The ZLinksList id*.txt, RLinksList id*.txt, ELinksList id*.txt  and MLinksList id*.txt databases
are created during the process of posting.

All databases are located in the Links folder.

4.3 Anonymity

Regularly (every 30 minutes by default, can be reset by user) XRumer refreshes its proxy-list, it is
needed  for  anonymous  work  -  to  hide  your  real  IP  address.  But  the  process  can  be  started
manually, in the Anonymity tab.

IMPORTANT!!! 
If you started the process manually, then wait for it to finish before starting posting process - that is
until the button has a Finished text on it.

For the check to be more safe and stable, it is recommended that you place a script on any of your
site and set up XRumer in the following way:

- Upload the proxyc folder on to any of your sites - that is the script that checks if the proxy is
really anonymous.

- Set to proxyc and all files in it CHMOD = 777
- Open the menu Options → Proxy-checking settings in XRumer
- In the field Checker script address choose Use own address  and enter the full  address to

the script.  Use the browser to make sure you typed the address correctly and the script  is really
there.

Proxy addresses are saved in the xproxy.txt file, later on are used in posting. 

By default proxy usage is turned off, and XRumer connects to the site through a proxy, only if the
current IP is banned on the forum. You  can  turn  on  constant   usage  of   proxies  -   in   the 
Anonymity   tab. It  is  recommended  to  use  the  option  from Option→Advanced options→
Special condition of anonymity →Do not post without proxy.
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If you want to read more about proxy you can do on WIKIPEDIA.  

Information about : HTTP - http://en.wikipedia.org/wiki/HTTP
       SOCKS - http://en.wikipedia.org/wiki/SOCKS
       Proxy server -  http://en.wikipedia.org/wiki/Proxy_server        

4.4 Scheduler

Located in the Scheduler menu on the top of the main interface.

  
The system of schedules is intended to make tasks scheduler for the program, which will be done
in order, until it reaches the last task. Also, it is possible cyclic performance.  

Usage:

1. Select necessary event from drop down menu Event. Specify parameters if they are necessary.
2. Select necessary action to be done from drop down menu Job. Specify parameters if they are
necessary.
3. Press the button Add job
4. If it is necessary to add more tasks in schedule, execute 1 and 2 items again.
5. If it is necessary to choose from current list of tasks any concrete event, click on it twice - in the
left it will appear the pointer (arrow).  
6. Select in checkbox Enable scheduler 

Accessible items from Event menu:
- Posting finished 
- Successful posts count more, then > 
- Time = … The Possible format of time: DD.MM.YY hh:mm:ss, either hh:mm:ss, or hh:mm. If, for
example, it is necessary to specify time of 7 hours 30 minutes it is necessary to be written 7:30 -
instead of 07:30 
- bproxу file size (Kb) more, then > 
- Current position in links database 

http://en.wikipedia.org/wiki/Main_Page
http://en.wikipedia.org/wiki/HTTP
http://en.wikipedia.org/wiki/SOCKS
http://en.wikipedia.org/wiki/Proxy_server
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- Active threads count =
- Previous job complete 

Accessible items from Job menu:
- Stop posting
- Start posting from the beginning 
- Resume posting from the last position · 
- Set current position in links database to = …
- Set current project to =
- Change mod to :
- Enable option: 
- Disable option:
- Set max threads 
- Refresh proxylist
- Change links database ID to =
- Return to first job in joblist

If it is necessary to change tasks places click the right button of the mouse on needed tasks of the
schedule and choose the action (Up or Down). 
 
In  the  left  column it  appear  the  pointer  of  current  task.  Double  click  and  you  can  rearrange  the
index to any position in the list.  

ATTENTION!!! 
While  in  the  scheduler,  it  is  impossible  to  make  changes  to  the  database  while  it  is  in  use.   If
changes  must  be  made  you  must  select  Stop  posting  job,  before  making  changes  to  the
(database name, position, or even change databases) while currently posting. 

4.5 Self-learning

The Self-learning mode is located in the menu on the top of the main interface.

ATTENTION!!!
This self-learning  system to unknown fields of forms (textarea, input, select, etc.)  it  is  intended
only for experienced users (the ones who know advanced HTML).

Tools
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1. Select Enable Self-learning mode
If  it  is  selected,  XRumer  will  analyze  unknown  forms  and  store  in  database  during  the  posting.
Also, will use the information on already known forms, to which managed to be trained earlier.  
2.  Field  types  to  analyze  –  indicate  the  necessary  fields’  types,  which  the  program  should
analyze. 
3. Add field for learning when – choose the situation, when program should store the unknown
forms for analysis. 
4. Save the description text placed above the fields – it is recommended to select this option
for simplification of the analysis. 
5.  Automatically  accept  program  assumption  about  fields  meaning  –  if  it  is  selected,  all
program assumptions of field value will be affirmed, without additional user confirmation.
6. Notify self-learning system about new field type encountered at … different websites - it
is indicated field frequency threshold. The program take on the analyze only the widespread fields
names which have met more than on N quantity of different sites. Other fields will be eliminated.
Recommended value - 1..3

Control panel 
 (the example of the list after posting on the database with enable mode of self-learnings resulted)
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To appropriate necessary field value - it is necessary:                                       
1. Select this field from the list.
2. Edit Field value  (from dropdown menu):

   NICKNAME – user nickname
   REALNAME – a real name of the user 
   PASSWORD – the password 
   MESSAGE – the text of the sent message
   EMAIL – an e-mail address
   SUBJ1 – heading topic 
   SUBJ2 – explanation to topic 
   HOMEPAGE – user homepage 
   ICQ – ICQ number
   CITY – user city
   COUNTRY - country
   OCCUPATION – user hobbies 
   INTERESTS – user interests 
   Custom  text:  -  value  specified  by  the  user  (to  fill  the  field  to  the  right  of  the  dropdown

menu)
3. Press Ok! 

The changes will be set up after closing the form. 

By clicking the right mouse button on the fields list, will bring up the content menu

1. Place  all  unchecked  to  ignore-list – all  fields, unchecked  by  checkbox,  will  be  placed 
to  ignore  list    (IgnoreList.txt file in FieldsForAI folder), and in subsequently to these fields will
not be given a value.
2. Uncheck all – remove all fields’ checkboxes, therefore all values are null. Use it only if you wish
to null  all  the values which the program has been trained to keep in the database.  Use it  only  if
want to null all values in which the program was trained.

NOTE:  in  this  screenshot  the  job  result  of  self-learning  system  of  with  enabled  option
Automatically accept program assumption about fields meaning 

Import  fields database 
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This tool is in self-learning menu.  The aim of it is to import database of fields of forms from other
programs for mass posting (as ex. SpamIT and VIP). During inporting of database,  XRumer will
check for dublicate entires. 

Name of  imported database  –  indicate  the  name of  file  from which  will  be  imported  fields.  To
indicate name of file press ...  
Import data to - The database where will be saved the data in XRumer : xas.txt (main database)
or xas_AI.txt (database formed during self-learning of program).
Fields type - value that will be given to exported fields (nickname, message text, title of message,
email etc.). 

Fields database format: 
1) Line by line -  each field name will be displayed on new line
2) In one line, per symbol: - all fields will be in one line separate by indicated symbol.  

Export fields database

The  tools  analogue  to  previous  with  opposite  function:  list  of  fields  is  exported  from  xas.txt  or
xas_AI.txt to txt file with desired format. 

4.6 Mass PM

Starting  with  3.0  version  program  can  now  post  in  Personal  Messages  to  registered  users  of
forums – it works with phpBB and VBulletin forums. Since version 4.0 XRumer work with Invision
Power Board (IPB). 

Usage: 
1)  Post  on  necessary  forums  by  selecting  the  mode  from  Option  →  Advanced  options  →
Posting  →Registering only (without posting).



Description of work 45

© Botmaster Labs, 2006 - 2008

2) Switch to Mass-PM mode.

3) Start posting by selecting the mode from Option → Advanced options → Posting → Posting
on behalf of a previously registered user.

As the Personal Messages system of mass posting is new in XRumer 3.0 and some of the forums
have a very reliable protection system against automated postings, such as (it is forbidden to send
the message more often, than 1 time in ~20 seconds, it  is forbidden more than 3-5 messages in
day, etc.).  However, we are constantly working on new ways to circumvent these systems. 

4.7 Working with emails

XRumer can activate automatically the profile by email. This has to be done for forums that require
after registration to activate account. 
 
It works 2 ways of activation (Options menu → Profiles activation via e-mail) 

1. Automatic mode.  
In  this  mode there  is  automatic  activation  running in  the  background  (without  user  participation)
through  the  specified  time  intervals.  The  process  is  displayed  in  Mail  tab  of  the  main  form  of
Xtumer. If in this mode activation takes too long and doesn’t activate - probably, the data of a mail
box  are  incorrectly  specified  in  the  project  (for  example,  the  mail  server  does  not  allow  to
download the letter under the pop-report)  

NOTE: in this mode, creation MLinksList database is not made, as activation is made directly at
once after reception of mail.  

 
2. Manual mode.  
After  going  through  the  LinksList  id*.txt  XRumer  is  switched  into  the  mode  of  downloading  the
activation links. It gets the e-mail from the address specified in the project file. This has to be done
for forums that require you to follow a link sent to your e-mail to activate your account.  
After  all  the  links  from your  e-mail  inbox  (the  number  of  mail  in  the  inbox  is  not  the  number  of
activation  links,  there  are  also  greetings  and  other  messages  from  forums)  the  program  starts
sending your message to the forums, meanwhile activating your account in them. 

3. Disable  
Account activation by e-mail will not be made. It is meaningful to choose this option if the posting
are making only in guestbooks / blogs. 
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NOTE: If the email used in project apply a nonstandard POP port to download the emails, then
this port should be set up in xpop.txt in the field [PORT] 

IMPORTANT!!! 
Before starting a new posting project check through a browser (Internet Explorer or other), that: 

1 specified in the project, email address is available on the specified data 
2 it is possible to uploading letters under the POP3-report
3 this email is not used before in previous dispatches 

Check email every... :  This parameter specifies frequency of requests for downloading emails.
This option will work if it is selected automatic mode.

Download email at the end of submitting: also work in Automatic mode. If it is enable,at the end
of posting XRumer will connect to mailbox and do activation of links. 

 

Download all emails, without filtering by header: if it's enabled, checking for activation link will be
made in all emails, not only in those from xpop.txt (but it will take the time) 

4.8 Graphic captcha decoding

During posting, by filling forms the program analyze, if there is a graphic protection on the form
(so-called graphics captcha - see http://en.wikipedia.org/wiki/Captcha). The program automatically
downloads the image, analyze it and fills, in form, the necessary field in appropriate way.   

Average size of images in bytes - 2…5 kilobyte
Average speed of image recognition - 10 milliseconds   

The list of captchas, which are known by last version of XRumer:  
http://www.botmasternet.com/pictocod/   

For experienced users only: 
Since version 4.084, in XRumer was added an option to created your own DLL-libraries to decode new
graphic captcha. These DLL-libraries should be placed in DeCaptcha folder, and create for each type
of images the file *.mask.txt (analog to default.mask.txt). 
Tools and examples for creating libraries you can find in DeCaptchaSDK_1.2.rar archive. 

To regulate the usage of internal (standard) and external (user's) functions use the option 
DecaptchaMode.

4.9 Text captcha decoding

Starting with 4.0 version, during posting, by filling forms, program analyzes, if there is protection text in
the form (so-called text capcha). It can be:
 
 The Question with arithmetic operation, for example  What is the correct answer for 2+2 = ? 
 The Phrase Enter in this field the word.... 
  The Logic question - for example, number of USA states, etc. 
 

The program uses universal algorithm, which quickly analyzes possible variants and fills the necessary
field in appropriate way. If the question contains arithmetic operation - the program counts the value
and substitutes result (thus, arithmetic operation can contain brackets, multiplication sign can be
expressed as a symbol * and x, etc.)

 Initial data for this algorithm are stored in textcaptcha.txt file, which is located in root folder of

http://en.wikipedia.org/wiki/Captcha
http://www.botmaster.net/pictocod/
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XRumer. File format is:

#main_phrase;tag_1;tag_2
variable_name

Or

#main_phrase
variable_name=value

The program searches for basic phrase in HTML-code. After, it searches for tag_1 and tag_2 (if are
specified), takes analyzed value between them, deletes from it foreign tags. Only after, XRumer
analyze if there is the arithmetic operation and substitutes value to corresponding variable (if value is
not specified in next line, obviously).        

Examples:

1.) #>Are you human? * <
 tc_answer=yes

 In this case, the program searches in form code for the phrase > Are you human? * <, and variable
with  tc_answer name - and if it is found, substitutes the value of this variable, equal yes (without
inverted commas)

2.) #>Please, input the word; ;
 confirmation_word

Here, to the program, the substituted value is not set. After, basic phrase > Please input the word
search of opening and closing double inverted commas will be made, and the found value will be
placed in variable value  confirmation_word
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5 Methods of promotion a web project

XRumer includes advance opportunities to promote a web project:

- search engine ranking 

- raising of direct traffic 

- mixed methods, etc

Main methods are: 

 Posting
 Question - Answer
 Mass-PM
 Refspam
 AntiSpam

5.1 Posting

 This is standard method: your message is sent to different forums, blogs, guestbooks etc. Read more

details in Posting –process.

How it works? 

1) select database in field: Links database ID

2) create a project (Project menu>New)

3) start posting by pressing Start button

Tips: 

- Set the number of threads in Multithreading tab (the speed of submitting depends of it). See

details here. 

- The success rate depends of different factors: 

  The size of message (it should be not too short and not too long). On different sites this

restriction is different.

  Content on message (if there are links in messages or not). On some forums there are

restrictions for new registered users. They can’t create new topics or can’t post messages

with links.

  Email used on project. There are forums that don’t allow to register username with email on

web.de or from .ru domain 

  Success rate depends also of parameters set in Speed & success rate

- If you submit in forums, it’s recommended to use BB-code for links in message text and for

signature. 
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5.2 Question-Answer

This method is like the previous one (Posting), but gives 100% guarantees from complaints of

unwanted advertise. The aim of this method is to create a dialog between several users. First the

questions are sent, for example “Can someone tell where I can find thematically site on fishing?” (of

course the text of message should be well-thought). Second the answer is sent (from different

username and IP), like “I found several days ago, a very interesting site http://… on ur theme. I

recommend it”

How it works?

1. Select database in field: Links database ID
2. Create a project with text with your question (Project menu>New).

3. Start posting by pressing Start button

4. At the end of submitting, change the type of database: from LinksList to RLinkslist (in Links

database ID field). This database contains links where the software will  answer in created topic.

5. Create the second project with text of your answer (Project menu>New). In this project enter new

information in fields: nickname, realname, email etc. 

6. If it’s necessary, you can turn on in “Anonymity” tab the usage of proxies. So the answers will be

from different IP. It’s recommended to update the proxy list before of submitting. Take into

consideration at using the public proxies the success rate will be lower in several times.

7.  Start posting by pressing Start button. It will start submitting the answer to earlier created topics. 

8. At the end of this submitting, go back to step 5 and do new submitting with new project with

message : “Confirm, the site is indeed a thing!”

Tips:

- The submitted texts can be different. It can contain a dialogue or questions that will start a

conversation with other users from forum. 

     -      It’s possible to answer to topic of other users. See information about rgen.exe and RLinkslist 

5.3 Mass-PM

This method is useful to rise direct traffic. You send the Personal message to all users (or part of

them) on all forums from database. Same as at posting, with multithreading several forums are

processed in same time, by sending personal messages to users from forums. In same time, forum

send the email with notification about PM. 

How it works?

1. Select database in field: Links database ID
2. Create a new project (Project menu>New) with text of personal message. The text can begin with

message: “Hello, #uname!”. In this case the program will use nickname of user. 

3. First time, use database with turned on option "Registering only”, obligatory with enabled “activation

by email” option

4. Set “Mass-PM” mode 

5. In Advanced options enable “Posting on behalf of a previously registered user” 

6. Press “Start” button.

Tips: 

- On many forums there are restrictions by time for sending PM (30 sec- 5 min); so it is
recommended to use this method with bigger number of threads then used at posting
process. 

- First of all, the program scanning the list of users. After finish, it’s sending PM. It will do from
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the end of list of users. That mean last registered will get first the message.  
- To edit template for user scanning, it's possible by editing the masspm.ini file
- At work with a big database of forums this method will add several time more traffic that at

simple posting, but it will be one-time effect. 

5.4 Refspam

The method consists in sending ref. queries to pages of the site, indicating the request 
referer="your_site" (“your_site” is taken from Project, field “Homepage”). As results, on those sites
where is installed Webalizer statistic (or other) on special page the address to your site will be shown. 
Main target of this method are search engines (search bots).

 How it works?

1. Select database in field: Links database ID
2. Create a new project (Project menu>New). The text don’t meter, the important is the “Homepage”

content.   

3. In Advanced option enable the options: “Enable refspam” and “Only refspam, without posting” 
4. Press “Start” button

 
 Tips: 

- Works only on those forums where is installed a specific stats module. On other forums it will
not get any effect. 

- It’s recommended to use proxies/SOCKS

5.5 Antispam

It’s a new technology introduced in XRumer. It’s used for collecting thematically texts with registered
account on forums, and future usage of them for promoting links (optional) in posts and/or signatures.
On many moderated forums it’s not possible to add links in message or signatures before new user
will not make 5-10 posts. That’s why is need to make several posts without any links/advertisement. In
this topic You can read some examples of setup and usage of this AntiSpam system.

Positive part of usage of AntiSpam system: 

+ High probability that the advertisement will not be removed by forum admin/moderators
+ A gradual increase of external links 
+ Possibility to "inject/hide" links in thematic words in posts 
+ High direct traffic and increase of PR from popular forums with a lot of users and good ranking. 
+ High relevant messages for forums, which will be commented by other users and this, will be
good even for forums.

Negative part of usage of AntiSpam:

  - A very small speed of posting (the process of creating of thematic reply is a complex process) 
  - High demands on PC configurations (at least 2 GB of RAM, Internet connection higher than 5
Mbps) 
  - System is in beta testing and sometimes can be some errors in thematic of posts

 How it Works?

The essence of the system is to select a topic randomly, created by people (so it is important to
use system on high moderated forums, which contains a minimum of advertising/spam). Its content
is analyzed, and then XRumer search on other forums for relevant (thematic) response on this topic. 

If the relevant (thematic) answer is found – XRumer is sending the response. If not found, XRumer
randomly take other topic to answer, the content is analyzed again, and again XRumer search for
relevant response on other forums. 
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If after 15-20 attempts XRumer will not find relevant reply for selected topics – it will send as reply
a neutral phrase (if the option is enable in program settings). 

Neutral response – it’s a text that can be posted in any topic, not deviating from his subject. Lists of
neutral words, in 6 most popular European languages, are stored in files Antispam \ Neutral \ *.
default.txt 
  Once You have made 5-10 topics, You can turn on the option of posting links/advertising:

  - Edit a profile, with adding links to signature field;
  - Add to messages your text from project 
  - Injection of links in thematic words of your message.

Scheme of usage of antispam system:

1. Select database in "Database links" tab. It is very important to use database with most secure
and high moderated forums, with minimum of advertising in them. So the best is to use XRumer
with manual decaptcha and (preferably), with usage of Anti-Captcha.

2. Create a project (text for posting) using menu “Project -> New”. At the beginning it will be better
to not use links in fields “Homepage” and “Signature”.

3. Set up “Only Registration” mode in “Advanced options”. It’s recommended to enable the
options: “Editing profile after registration” and “Load avatar at profile editing”. It will be
double advantage: personification of registered profiles and links to successfully created profiles
will be saved in “Profiles” (will be useful in future).

4. Press “Start” button

5.  It’s recommended to wait 1-7 days after the profile creation is finished (full database). In this
period of time it’s recommended to gather additional information for  AntiSpam system. Enable
the option “Collecting information for reply”, and the program will gather the content without
any posting. Gathering can be made  with same database or another database, bigger one. 
“Registering only” mode should be disabled in “Advanced options”. Gathered information is
saved in AntiSpam\nodes.txt file. To process to next step the size of nodes.txt file should be at
least 100Mb (recommended file size - more than 400Mb).

6. Enable in “Advanced option” : “Posting on behalf of a previously registered user” 

7 Select same database, earlier used for registering profiles. Or to get better speed of submitting
you can do following: 

– Take the “Profiles” report (created when you made step 3 and 4 )  
– Using “Links post-processing” tool, converts the report from folder

Logs\name_of_project\Profiles id*.txt
– Rename the file Profiles id*.txt  to file  LinksList id*.txt (instead of * use a number) 
– Move the file in folder Links

8 In AntiSpam system enable “Posting of thematic replies”. To avoid overload, it’s
recommended to reduce the number of threads and the option “Posting on behalf of a
previously registered user” to disable. 

9 Start submitting by pressing “Start” button

10  It’s possible to do repeat the process over and over by doing a schedule by the scheme (as
example) : 
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11 In future, after 5-10 processes, you can add the link in the project in Homepage and Signature
fields. Enable “Posting on behalf of a previously registered user”. It’s also recommended to
insert links under the keywords. For this you need to set the list of keywords as 
[words]word1,word2,...wordN[/words]. Read more details in Program settings> AntiSpam
system

 Tips: 

– Speed of posting of thematic replies is very lower, because it takes time to find proper text for
reply. But the way the high speed of submitting by this system it’s contraindicated, because it
may put unnecessary suspicion of moderators/admins

– If in replies are too often used neutral phrases, that mean the parameter Min. thematic level is
too high, or gathered information size in Antispam\nodes.txt is too small. 

– If it’s planning to use this system in English forums then need to gather maximal size of file
Antispam\nodes.txt only on English forums. It’s important that the database should contain links
with non-spammed,most secure and high moderated forums, with minimum of advertising in
them. 

– If XRumer have replied improperly, that mean the software was not found in Antispam\nodes.txt
any proper and relevant topic. It’s important to understand that it’s not easy to find proper reply
to each topic.   

 Files from AntiSpam System:

AntiSpamServer.exe – application, run in background and provides a selection of topic. For normal
work of system, check the firewall if is not blocking it.

 AntiSpamServer.ini – most important logic of system. All settings are commented in detail.

badwords.txt – words are phrases forbidden to use in the reply and in Topic name (where reply will be
made) 
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cutafter.txt – phrases, after which the reply will be cropped

nodes.txt – database of topics for reply

printversions.txt – print version of topics, for faster download (for moment, it’s inactive).

 xpostmask.ini – masks to retrieve posts from topic.
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6 Macroses in the message text

Macros - special commands and notes which allow the additional updating of the posted text. See
enclosed sections. If the macros are used in the project, don't forget to press Test button to see
the preliminary text. 

o  Variation system
o  Using BB-code
o  Link Disguise
o  Additional macros

6.1 Variation system

 The basic syntax 

If you want to post a few different message texts, you can use a built-in variation system. You can
use  it  both  in  the  message  text  itself  and  in  the  Topic,  City,  Country,  Hobbies,  Homepage  and
Interests fields.

The syntax for the variation system is as follows:

{variant_1|variant_2|…|variant_N}

Thus, there are only 3 keywords in the system { , | , }. The | separates variants. Amount of variant
is not limited.

An example of the system usage in the message text:

{Good day!|Hello!|Hi everyone}  
{Check out|I've recently found}  
{a marvelous|an excellent} search engine – http://www.yahoo.com  
 
P.S. Yahoo – everything will be found! Google: nothing was really lost…  
 
{Bye to everyone!|See you!}  

As a result the following text, for example, will be posted to one forum:

Good day!
I've recently found an excellent search engine –
http://www.yahoo.com
P.S. Yahoo – everything will be found! Google: nothing was really lost…
Bye to everyone!

And different text variation will be posted to another forum:

Hi everyone.  
Check out a marvelous search engine – http://www.yahoo.com  
 P.S. Yahoo.com – everything will be found! Google: nothing was really lost…  
 See you!  

Each  time  variants  are  chosen  randomly  and  the  more  choices  the  better.  So,  any  level  of  an
enclosure is possible. No link to the topic name is made.

IMPORTANT!!! 
When using variations always check them first with the  Test   button in  the project  window. It  is
advisable to always check before starting the posting process!



Macroses in the message text 57

© Botmaster Labs, 2006 - 2008

 Additional opportunities

1.) Co-variation – to choose of identical variant number.
Syntax:

{#1 variantA| variantB|...| variantZ}
...
{#1 variantC| variantD|...| variantE}

where #1 - the binding identifier. Instead of 1 can be any symbol. The main thing that this symbol
must be the same in those variations where you wish to be binding under variant number. The
variations amount necessarily should coincide.

In an above mentioned example, variants will be bound, i.e. if in the first variation will be chosen 
variantA in the second it will be necessary variantС if in the first variantB - that in the second
variantD and so on.

Examples of correct use in text:

[url=http://site.com/{#Alink1.htm|link2.htm|link3.htm}]{#Aanchor1|anchor2|anchor3}[/url]

...Search for {#Zgenuine spare part |spare parts to foreign car}, suggest a{#Zshop of autospare
parts for the foreign cars| a suitable dump}...

Examples of misuse in text:

{#Avariant1|variant2} ... {#Avariant1|variant2|variant3} 

– it is incorrect use because the number of variants does not match 

2.) Binding by domain zone.
Syntax:

{#.com text_for_zone_com|#.ru text_for_zone_ru|text_for_other_zone}

After the instruction of the zone it should be a space. 
Example:

{#.ru Добрый день!|#.fr Bonjour!|#.de Guten tag!|Hello!|Hi!|Hello all}

In the resulted example for all domains in zone RU this line will be replaced on Добрый день!, for
all domains in zone FR - on Bonjour!, for all domains in zone DE - Guten tag!, and for all other
domains - a casual variant from last 3 - or Hello!, or Hi!, or Hello all.

6.2 Using BB-code

For promoting your site under certain keywords BB-code usage is recommended.
It has the following syntax:

[url=http://www.your_link.com]keyword[/url]

Where keyword – is the key link or phrase.

As a result the following link would be posted to a forum:    keyword

Here you can read mode about BB-code 

http://en.wikipedia.org/wiki/BB-code
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6.3 Link Disguise

 
Starting from 2.7 version of the program, the system of the plain text disguising as the links was
introduced into the program. It should be used at the necessity to conceal the links from the forum
administrators.
To achieve this, the disguised text shall be marked out with the following code:

[color=color_url]...[/color]

IMPORTANT!!!
With macros should allocate the text, instead of links. The meaning of its action consists in making
the usual text to look as the link (underlining, color, etc.), in consequence, the text is merging with
links and links become not visible.

Example: 

[color=color_url]...  the usual text...[/color]  [url=http://link]link text[/url]  [color=color_url]...  continuation
of the text ...[/color]

The program will  analyze the CSS-code and use the corresponding color and style. This will  not
slow down the posting process.

6.4 Additional macroses

#category  –  if  use this  macros in  text,  during the posting in  the  message it  will  be  changed on
category name in which the post is placed (but at posting thought ZLinksList database this macros
will be replaced with word this).
#hostname – the same, it will be replaced on forum/site name in which the post is placed 
#random[variants] - Generation of random symbol or word from the specified range

Examples: 
#random[0..9] – it will be replaced in the text with a random number from 0 to 9 
#random[a..z] - it will be replaced in message text with casual letters from a to z 
#random[a..z,0..9] - it will be replaced in message text with casual letters from a to z or from 0 to 9
#random[a,b,c] - it will be replaced in message text to one of this letter - a, b or c

#file=file_name - replacement by contents of the specified text file. It works only in Message text,
Topic or Explanation fields. For a more advanced premise of usage of macros in the text, there is
a corresponding button on the form of editing on the project.  

The example of macros usage in text: 

{Good afternoon | Hello}
The  interesting  name  of  a  site  -  #hostname,  how  you  managed  to  get  such  interesting  domain
name?
Very interesting site though there is no couple of categories. 
But the category #category here is very good.

#file=C:/temp/mytext.txt

I spent #random[5..9] hours searching in the network, until find your forum! I think, I shall stay here
for a long time!

#gennick [identifier] or #gennick [identifier, min_lenght, max_lenght] - generate casual
nickname with attachment to the domain name + to identifier. The identifier is any casual characters
set by user. 

IMPORTANT: at each new dispatch, it is necessary to change the identifier to new one. In case of
parameters task min_lenght and max_lenght the nickname length will be generated in the set limit.
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This macros is recommended to use in Nickname field.

Examples:
#gennick[dtmgbofl]
#gennick[500sdfgd]
#gennick[dfvdfdf, 6, 20]

#file_links [file_name,number_lines,formation_method] - Replacement of several casual chosen
lines from specified file. Formation method is the key, which sets formation method of resulting list:  
 

 S - in one line through blank
 L - in each line
 N - in one line without space 

If the key is not specified, the formation method will be (L) on each line . 
If the path to file is not specified, then the file is loaded concerning the root folder of the program. 
If the specified file does not exist, macros will return an empty line.

This macros is recommended to use in Message text field. 

Examples:
#file_links[C:\myfile.txt,10,S]
#file_links[\subfolder\testing.txt,200,L]
#file_links[D:\Temp\Trash.txt,3]
#file_links[http://mysite.com/textfile.txt,3]

#err [error_maker] - generator of typed errors, sets the share of typing errors (error_maker value -
number from 0 up to 10000, the bigger value will cause more typing errors) in all text. This macros is
possible to use in any project field, but it will be better to use it in  Message text, Topic, Explanation
fields. This macros influences only the text - the BB-code is not exposed to influence of.

Examples:
#err [1000] I am sorry for typing errors.... Very small keyboard on PDA! #err [0]... this text will be
without misprint...

#nomacros... #endnomacros - disables all macros between these words. It should be used, if, for
example, it is necessary to use braces as text, and not as variations.
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7 Internal programs file

In XRumer are some file, placed in main folder, that helps to operate with logic and algorithm of
software. It gives more opportunities to user to teach the software to new specific resources (links
catalogues, guestbooks etc.). Here you'll find description of most important files as: 

 xas.txt and xas_AI.txt
 xurl.txt
 xmessage.txt
 x_user_agent.txt
 xpop.txt
 xseek.txt
 xmaxlen.txt
 xignoreforms.txt

7.1 xas.txt and xas_AI.txt

Description
These files contain associative information to fill fields form (Xrumer association). 
xas.txt  - it  is main file from program structure. It  is not recommended to edit  this file without good
knowledge of HTML. 
xas_AI.txt  -  additional  file  created  automatically  as  results  of  working  with  self-learning  system.  
XRumer will use this file only if will not find needed format in xas.txt file. Besides, xas_AI.txt will be
used only if self-learning system is ON. 

Syntax 
In both files, syntax is same: 

#field_name1;field_name2;....
assign_value 

Field_name -  it  is  name of  field  in  HTML (ex:  in  <input  name=login>  -  name of  field  is  login),  and
assign_value - it is value of following fields: 
NICKNAME - nickname of user
REALNAME - real name of user
PASSWORD - password
MESSAGE - text of message
EMAIL - email box
SUBJ1 - topic
SUBJ2 - explanation 
HOMEPAGE - homepage
ICQ -  ICQ number
CITY - city
COUNTRY - country
OCCUPATION - occupation(hobbies)  
INTERESTS - interests
SIGNATURE - signature
SECRETCODE - value of decoded captcha 
any other value - value entered by user 

Field_name can begin with !. In that case, it means it should be entrance of this word in field name.
Those words that are at beginning of file (in top) have high priority. 

All changes will be available only after restart of software.      

Examples
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#!email
EMAIL

That means: fill all fields that contains word email(ex: user_email, EMAILADR, YoureMail1 etc.) with
value EMAIL, i.e. email address used in project.    

#company;organization;project
SPAM Inc.

According to these lines XRumer will fill all fields with names company, organization and project with
value SPAM Inc.

7.2 xurl.txt

Description
This  file  creates  the  logic  of  running  through  resource  (finding  link  to  forum  section,  creating
topic/message, registration etc.). It contains a list of meta-commands, which are setting the rules of
surfing through resource. High priorities have lines that are at beginning of file (in top). 

Syntax 

AddLinkRule([search_area,'line', unnecessary_parameter_logic,
...
], meta_links);

search_area - number use to set place of line search: 0 - link in bottom; 
1 - link as is in HTML-code;
2 - link with anchor in bottom; 

line - line that should be in search area to work this rule.  
unnecessary_parameter_logic  -  in  this  line  can  be  used  or  not  word:  false.  If  the  word  false  is
used, this line will not be used in search area. 
meta links - it is a mark, by which link will be marked, if set rule is fulfilling:  
URL_TOFORUM - url to forum
URL_TOGUESTBOOK - url to guestbook
URL_TOSEARCH - url to search on site (it is reserved, not used)
URL_TONEWS - url no news (it is reserved, not used)
URL_TOVIEW - url to view forum category 
URL_TONEWPOST - url to new post / topic
URL_TOREPLY - url to reply (created after posting)
URL_TOEDIT - url to edit the topic
URL_TOREGISTRATION - url to registration 
URL_TOLOGIN - url to login
URL_AGREE - url I accept the rules. 

Examples
AddLinkRule([
2,'sign',
0,'sign.asp'
],URL_TONEWPOST);

This rule indicate to software that all links which contains sign.asp or url with anchors containing sign
- to create new post. 

AddLinkRule([0,'action=logout'
],'');

This rule indicate to software that all links which contains action=logout should be ignored. 
ATTENTION ! as meta links is used two (2) apostrophes, and not double quotes.  

AddLinkRule([1,'board,',
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1,'.0.htm',
1,'action', false
],URL_TOVIEW);

This rule indicate to software that all links which contains board and 0.htm, but NOT contains action -
links to view forum category. 

7.3 xmessages.txt

Description 

This file contains flags, that determine internal situation of program for each tread. There are such
situations as obligatory registration for searching, looking for registration form, in this forum need a
delay between posts, wait 30 sec etc.

Syntax

#marker1;marker2;marker3;....;markerN
flag1
#marker1;marker2;marker3;....;markerN
flag2

where marker - any line, in case if this line is in content of current site  - then related flag is used. The
values of flags:

FORUM - this recourse is good for posting (forum / guestbooks / ...), can find form
SUCCESS - after posting the site reported that message is sent successfully
REGANYWAY - registration required 
MUSTREGISTERANYWAY - registration required
MUSTREGISTER - registration required
INVALID - error 
NOT FOUND - error 404 Not Found
PRESSAGREE - must to submit form with button I Agree
ALLOW - now you can leave the message
ANONYM - can post as guest (fields login and password can be leave blank)
NOPASS - registration not required 
LOGGEDIN - logged in successfully 
BANNED -  on this forum IP is banned, must to enable/to change proxies. 
WRONGPLACE - it's forbidden to post in this category (or in this category can post only administrator
or moderator) 
WRONGACCOUNT - wrong login or password 
ACTIVATION - before posting, account must be activated by email.
CHECK - need to submit seconde time (Please check your post, and press send...)
BBCODE - BB-code is used on this forum
PICTOTRY - need to download, decode and resubmit captcha.
PREMODERATION - pre-moderation is enabled on this forum (post must be approved by moderator)
TOOLARGE - the message text is too large (the program will cut it automatically)  
BADEMAIL - email used on this forum is banned / not allowed (for example: by domain zone .ru)
TAKEN - this login is already used (change Nickname field in your project)
TOOFREQ - too frequent attempts to post on this forum from same IP, the program makes pause. 
REMOVEURL - can not use URL in field Home page (second submit will be made without filling this
field)
MAX500 - maximal number of symbols in message - 500, the post will be cut and re-submitted. 
WAIT - too frequent attempts to post on this forum from same IP, the program makes pause.
FORCE_TEXTAREA - at topic creation, the program will submit the message even if in form texarea
field is missing
FORCE_SUBJECT - at topic creation, the program will submit the message even if in form topic
subject, nickname and email fields are missing
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Examples

#thank you for you message!
SUCCESS

In this case, if after submitting the program will find in HTML-content the text thank you for your
message! -then the link will be placed in Successful report.

#You are banned on this forum!
BANNED

In this case, if after submitting the program will find in HTML-content the text You are banned on this
forum! - will match with BANNED flag, so the program will enable the option  to use proxies. If proxies
are used then it will change proxy to another one from list.

7.4 x_user_agent.txt

Description

This file contains a list of User Agent, which are used in GET and POST methods (User-Agent: ...). At
submitting User-Agent is choose arbitrarily for each tread. 

Syntax

user-agent1
user-agent2
...
user-agentN

Examples

Mozilla/4.0 (compatible; MSIE 7.0b; Windows NT 6.0)
Google Bot

7.5 xpop.txt

Description

This file help to manage the work with email service, to extract activation links from emails, and login
and password (if it is necessary).

Syntax 

File contains sections which define rules of work: 

[USERNAME], [PASSWORD], [HOST] - these sections don't have any influence on work with email,
because are defined from XRumer's project.
[PORT] - port, used for POP3-server (connection) 
[HEADERNEEDS]...[ENDLIST] - templates of headlines of letters, which are necessary for reading
[LINKNEEDS]...[ENDLIST] - templates of activation links, which are extracted from emails. 
[USERNAMENEEDS]...[ENDLIST] - templates of phrases for extracting login from email (if login is
sent by email on this type of forum)
[PASSNEEDS]...[ENDLIST] - templates of phrases for extracting password from email (if password is
sent by email on this type of forum)

 In section [USERNAMENEEDS] and [PASSNEEDS] the line [TO][CR] means to remove the word to
end of line. 

Example: 
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 Your password is: [TO][CR]
 
 it mean to extract all from phrase "Your password is:" - till the end of the line.   

7.6 xseek.txt

Description 

This file help during the process of submitting mark the sites (forums, guestbooks, blogs, etc.) in
HTML-content of which contains specific text, or words. If during the submitting in HTML- content
contains these words, then the program will add in reports (Successful, Part.Successful etc)

Syntax

In xseek.txt, words and phrases should be one in line: 

word1
word2
....
wordN

Examples

If you'll enter, in xseek.txt, following words: 

SEO
search engine optimization

so during the submitting, if these words and phrases will be in content, the program will mark in reports
(Successful, Part. Successful, Other etc.) the sites where was find such words. 

7.7 xmaxlen.txt

 Description 

This file describe the attributes of resources on which the message should be reduced, so the
software be able to post message.  

Syntax

 #attribute1
 max_length1
 ...
 #attributeN
 max_lengthN

7.8 xignoreforms.txt

Description 

This file lists the signs of forms, which need to ignore (to not fill, to not send) in different mode.

Syntax

 [ANY]
 signs for all modes 
 [PM_NEWMESSAGE]
 signs for new topic creation mode
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 [PM_REGISTER]
 signs for registration mode
 [PM_LOGIN] 
 signs for log in mode
 [PM_EPROFILE]
 signs for editing profile mode
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8 Plugins

The option to use plugins was added since 4.0 version   - dynamically included units. All are stored
in Plugins folder. 

It is possible to use this type of plugins: 
 tools
 links converter
 capcha decoding 
 text capcha decoding 

8.1 Wordtracker + bids checker

This plugin was built for parsing Wordtracker with paid or free username, checking bids of keywords
in PayPerClick system in : UmaxLogin, PeakClick, KlikVip

This plugin is under construction. 
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9 Additional programs

 
 In the set with XRumer program there are some additional programs simplifying work and adding
new opportunities.

o Control.exe
o Secure.exe
o Rgen.exe
o Mgen.exe
o XRumer Addin

9.1 Control.exe

 
This program is intended for the control of constant start of the assigned application.

Interfaces:

1. Controlled application – the name of controlled application (it is set up by pressing right
button) 

2. Settings – there are the settings:
   Control of permanent running - The program will check every minute, if the assigned

application was not closed
   Restart every ... minutes - The program will restart assigned application through the specified

minutes. Restart will occur a few seconds after closing in order for the correct saving of controllable
application 

9.2 Secure.exe

The aim of this program is to secure your login and password. Secure.exe will generate encoded file
with your login /  password - for its future remote use. This tool should be used, if exist a high risk of
theft of your login / password by strangers from computer, where XRumer run

 1. Login - enter the login from www.botmasternet.com
 2. Pass - enter the password from www.botmasternet.com

http://www.botmaster.net
http://www.botmasternet.com
http://www.botmasternet.com
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 3. File - specify the filename, where the code will be saved. The extension of file can be: *.txt, *.php,
*.htm, etc.

After file will be generated, upload it through FTP on any of your sites, then enter path to the file in 
[Settings] section from xuser.ini file  
 RemoteInfo=http: // link_to_file
 (The link should be with http://)

After you have entered the path, the login and password can be deleted from xuser.ini file, because
this information is encoded and remote stored. You can always delete / move / rename this file in case
you have suspecting the steal of information.     

9.3 Rgen.exe

The aim of this program is to convert text list of links to topics into links database RLinkList. 

The program rgen.exe works with forums on phpBB, IPB (Invision Power Board), VBulletin, ExBB,
YaBB and some others. This tool will help you to : 
1. If it necessary to send reply to already existing topics (it can be gathered with Hrefer) 
2. to post many messages to different topics of same forum. 
3. Increase existing RLinkList database, using for it Successful reports  
4. And in some other situations. 

1. Scr.file - name of source (Successful report, or text file with links list to topics view).
2. Dest.file - name of destination file (RLinkList database).  
3. Place to the dest.file only converted links - if this option is ON in destination file will be placed
only converted links. 
4. Filter doubles by topic ID: select last topic on identical forums - this option is turning ON a
special duplicates filtration: from different topics on same forum it   will add in list only last created
topic.

9.4 Mgen.exe

This program will help you to convert database of letters from the programTheBat!  into database of
links of activation MLinksLink. Program mgen.exe will be useful in case you have made posting using
email services that is not working with XRumer (such as gmail).

1. Source - name of file from TheBat! where are stored database of letters.
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2. Destination  -  name of  destination file  od MLinksList  database.  In  this  file  are saved all  activation
links. 
3. Rewrite destination file  -  by turning ON this option old MLinksList  will  be rewriten over  with  new
one.

9.5 XRumer Addin

Additional program XRumerAddin-Setup.msi will install a button in Your browser panel, and let you to
full fill all fields which are in Project used in XRumer. This option will work only on IE 7.0. To use this
option XRumer should be open.  
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10 FAQ

o  General questions
o  FAQ on posting process

10.1 General questions

1.  Is it possible to start several copies of the program in one and the same computer?

No,  you  should  not  do  this.  Since  two  copies  of  the  program  can  conflict  with  each  other.
Moreover, this will not accelerate the posting process, but will result with twice-slower operation of
both programs.   

2. Can I start the program on several computers, for example, at home and at work?

Yes,  you can.  There is  no specific  link to  your  computer  or  IP.  There  is  a  link  to  your  login  and
password indicated at registration on site http://www.botmasternet.com/  
However, it is forbidden to start the program IN SAME TIME on more than 2 different IP.  

3. Is it possible to use different profiles in the program?

Yes, it is possible.  

4. I start the program on the removed server and because of animation, display of posting
is slower. Is it possible to disconnect somehow animation feature of the program?

Yes, it is possible. For this purpose, it is necessary to disable the option from Options> Advanced
options > Visual effects. 

5. Is there any work being done to improve the program operation and efficiency?

The XRumer program is being improved and upgraded almost every day (the program learns to
work with the new types of forums, gustbooks, blogs, additional capabilities are introduced, etc),
the  site  is  updated  every  week.  However,  in  case  you  violate  the  program  non-distribution
condition, you run a risk of being cut off from the system (your account will be banned) and you will
not be able to get the updates and technical support.

10.2 FAQ on posting process

1. Is it possible to post different texts and links to different forums?

Yes, certainly. Read Variation system section carefully.  

2.  I  made  the  project  file  and  started  messaging,  but  the  reports  show  very  few
successfully posted messages. What can cause this problem?

Probably you use a too short nickname or title, or outdated (inactive) proxy-servers – in the latter
case it would be better to disable them in the Anonymity tab. On the other hand, the problem may be
if there are many forums requiring e-mail registration in the selected link database (such forums are
automatically processed later).  

3. The program failed to post messages to some blogs (or guestbooks). The report states
it is not a forum. Is it right?

Yes, everything is OK. But we would like you to send us the links to these blogs (or guestbooks).
Then the next program version will work with these site types normally. Originally the program was
created for posting only to the forums, therefore it lacks sufficient knowledge of the guestbooks and
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blogs.  

4. Does the program require much Internet traffic?

Yes, rather much. This is required for the analysis of forums and forms for filling in. Therefore it
is strongly recommended to use high-speed Internet channel without any traffic  limits – just  as for
any program of this type. The traffic charge is reduced in some times by posting through ZLinksList
id*.txt and by enabling Express post mode  

5. How can I accelerate posting process?

During the first messaging you can increase the number of threads in Multi-threading tab, during
the second messaging you can use the ZLinksList id*.txt, database generated in the process of the
previous  messaging  –  this  will  make  the  process  5  to  7  times  faster.  Besides,  starting  from  2.7
version the program includes an additional express-posting mode that affords posting speedup.  

6. Shall the forum and guestbook database LinksList id*.txt contain the links to the forum
main pages or directly to the forms to be filled in?

It does not matter. The program itself will analyze the forum, find the most suitable topic and link
for posting the message.  

7. Why did the program fail to post the message to the guestbook using the pictocode?

At  present  the  program  can  decode  the  pictocodes  only  from  the  forums  and  a  few  types  of
guestbooks. See http://www.botmasternet.com/pictocod/.  

8. Please explain the purpose of the button Get the activation links from the mailbox.

The program enters the e-mail indicated in the project, downloads messages with the links for
activation into MLinksList id*.txt, file and then provides posting in this new formed database.  

9. I would like to perform messaging in the whole database, with posting to 100 forums
per day. How can I do this?

Assign the periodicity in the multi-threading setting with the posting interval  100 messages per
24 hours, millisecond being applied as a unit.  

10. Links flashing at the top of the screen are disturbing...

This is monitoring. It can be disabled in Advanced options tab.  

11. Can I use SOCKS-proxy?

Yes, you can. The list of SOCKS-proxy is stored in xsocks.txt file, unlike http-proxy this list shall
be supplemented manually. It is very important to have operative SOCKS-proxy.  

12. Why did the program fail to post a message to a forum?

This  can  be  caused  by  several  reasons,  and  namely:  either  links  placement  on  site  (or
guestbook/blog,  etc)  is  forbidden,  or  e-mail  activation  is  required  and the  program works  with  this
forum later,  or  an inoperative proxy is  used,  or  the  used proxy  is  operative  –  but  it  does  not  gate
through  POST-  queries,  or  the  project  file  is  improperly  made.  In  any  event  if  you  see  that  the
program MUST be able  to  post  the  message to  the  specific  site  since  it  can  be  done manually  –
send the address of this site to botmaster.net@gmail.com by e-mail.  

 
Besides,  posting  mode  probably  differs  from  the  mode  you  want  –  for  example,  MLinksList

mode is retained from the previous operation. Be sure to check the mode before starting the work.  

13. I failed to completely realize the principle of activation links processing. What is the
difference between the files Activation id*.txt and MforumList id*.txt?

http://www.botmaster.net/pictocod/
mailto:botmaster.net@gmail.com
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Activation id*.txt is just a report that is formed in the process of posting. It includes the links to
the  forums  with  the  requirement  You  must  activate  your  account  through  e-mail.  Further  on  this
report  is  not  used at  all.  Activation links are gathered  either  manually  pressing the  button  Get  the
activation  links  from  the  mailbox  or  automatically  on  completion  of  messaging  in  LinksList  id*.txt
base. During the process of the activation links downloading from the mailbox they are placed into
MLinksList id*.txt file. Frequent mistake: one may think that the number of messages in the mailbox
corresponds to the number of links. But this is not the case! In fact, there are plenty of meaningless
messages among these letters – something like Thank you for registering on our forum, etc – the
program does not download such messages. Further on when all  the links have been downloaded
from  the  mailbox,  XRumer  automatically  switches  over  to  MLinksList  mode  posting  (and
simultaneously activating) to already downloaded activation links. 



Part

XI
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11 Recommendation

  Do not use too short and simple nickname in new project. If it is something like  Bill or Alex - a lot
of forums already have such nickname registered and the program will not be able to post in them.
 

  To achieve better effect you need a thoroughly elaborated message text. If you write something
like Hi! Visit a great site, here http://mysite.com - there hardly be any effect and moderators will
surely delete that post. The best way is to use hidden advertising.  

  The same thing can be said about titles. Do not write Cool site, Super!!, etc. It is strongly
recommended to use 3-4 words in the title and for better effect use the Variation system.  

   After creating the project file make sure that you have loaded the forum databases that you really
need and LinksList mode is on.  

   Download activation links AFTER going through the whole LinksList database.

   To post faster and to increase success rate use elite, paid proxies. They work faster and more
effectively, than public-proxies. 
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